Using Blackboard.com Software to Reach Beyond the Classroom: Basics

NESA Conference 2007

Presenter: Barbara Dent
Educational Technology Training Specialist
Thomas Jefferson High School for Science and Technology
6560 Braddock Road
Alexandria, Virginia 22312
Barbara.Dent@fcps.edu
Overview: Why are you creating a course? What products/competencies do you need to have in order to create a course?

Course Design: What will your course look like?
- Logins and passwords
- Overview of course site
- Control panel
- Course options

Course Content: What do you want to include in your course?
- Course information
- Course documents
- External links
- Learning Units
- Announcements
- Staff information
- Assignments

Course Communication: How will you and your students “talk” in the course?
- Discussion Board
- Manage/Create Groups

User Management: Who’s in your course?
- Enroll users
- List/Modify users

Resources on Blackboard
Overview: Why are you creating a course? What products/competencies do you need to have in order to create a course?

Blackboard can be used in a simple form to post homework and other class information or it can be used as a dynamic tool that allows students access to handouts, worksheets, lessons involving multimedia and other information.

Each of your students will have his/her own login and password to your site. Your course will be using Web-based software created by Blackboard, Inc.

For your Blackboard course you will need the following products and competencies:
- A live Internet connection. For minimum acceptable performance, Blackboard recommends at least a 56K modem connection, although it can be accessed with slower connections.
- A Web browser – Netscape Navigator or Internet Explorer, version 4.0 or higher
- An email account and the knowledge of how to send and receive email
- The ability to navigate the Web and handle multiple open windows
- The ability to open, close and save files and attachments

Since Blackboard is a Web-based application, everything entered into the Blackboard forms is dynamically generated as Web pages within a course Web site. Files that are uploaded/attached are not converted to Web pages; instead, they are treated as attachments, and are opened and displayed within the appropriate software package. It is very important to remember that any type of file can be uploaded into a course Web site, but your students must be able to open that file by way of the files’ specific software package, plug-ins, players that are usually downloadable from the Internet for free. Examples are: Adobe Acrobat Reader, QuickTime, RealPlayer, Flash, Shockwave, PowerPoint Viewer, Windows Media Player.

Instructional design plays an important part in developing online education. This simple Instructional Design model may provide some help in setting up a course Web site:

**Analyze > Design > Develop > Implement**

The most difficult part of creating a Blackboard course is the planning stage; the technical part of putting up your information is easy.
Course Design: What will your course look like?

- **Logins and passwords**
  Access to the course requires a User Name and Password on the Blackboard system.
  1. Launch Internet Explorer and go to: http://nesa.blackboard.com
  2. Click on the Login button to start the process.
  3. Enter the Username and password that have been provided for this training. The password is case sensitive and must be typed in with exact upper and lower case characters.

  *Students should be instructed to change their initial password once they are logged in. To do so, have students go to My NVS > Personal Information > Change password*

Once you are logged in you will see several tabs across the top of the screen: **My NVS, Courses, NVS Faculty**. These tabs are always available. Clicking on the **My NVS** tab will always take the user to his/her personal starting page. Clicking on the **Courses** tab will always take him/her to a listing of all the courses he/she is active in, either as a teacher or as a student.

4. Click on the **Courses** tab to see the courses you will be working with.

- **Overview of course site**
  When you enter a course you immediately see the **Announcements** page. As you create your course, anything you put in the **Announcements** sections will automatically appear here. The Announcements section collects all of the announcements from your courses and the School into one common area. By default, you view today’s announcements. You can also view the week’s announcements, the month’s announcements, or all the announcements that have been posted in all of your courses.
On the left-hand side of the window are navigation buttons used to view various areas of the course.

5. Single-click on any of the buttons. These buttons will take you to the different sections of the course. While exploring the basic set-up, notice that the buttons are always available to you no matter what part of the course you are in. You should always use these buttons to navigate the course rather than the Back button in your web browser.

Here is a description and example of some of the navigation buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Application – Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements</td>
<td>New information about the course – room changes, quizzes, chat room meetings.</td>
</tr>
<tr>
<td>Course Information</td>
<td>General information – syllabus, grading policy, assignment schedule.</td>
</tr>
<tr>
<td>Staff Information</td>
<td>Instructor’s information – office hours, email address, phone number</td>
</tr>
<tr>
<td>Course Documents</td>
<td>Course Content – lecture outlines, lessons, required readings, presentations, etc.</td>
</tr>
<tr>
<td>Assignments</td>
<td>Assignment listings – class projects, research, links to quizzes</td>
</tr>
<tr>
<td>Books</td>
<td>A listing of books used for the course.</td>
</tr>
<tr>
<td>Communication</td>
<td>Links to communication tools – email, discussion board, virtual classroom</td>
</tr>
<tr>
<td>Virtual Classroom</td>
<td>These buttons provide direct links into each individual area of the course site</td>
</tr>
<tr>
<td>Discussion Board Groups</td>
<td></td>
</tr>
<tr>
<td>External Links</td>
<td>Links to web pages – sites which contain content covered in the course</td>
</tr>
<tr>
<td>Tools</td>
<td>Access your information – send and receive files, gradebook, calendar</td>
</tr>
</tbody>
</table>

- **Control panel**

Located below the buttons or text panel is the **Control Panel**. As the instructor, you will create and modify your entire course through this **Control Panel**. This **Control Panel** is not available to students!
6. Single-click on the Control Panel to see the following Control Panel window:

- **Course options**
  In this workshop you will learn how to customize your course to reflect your own personality and preferences.

**Course Information**

7. In the Course Options section of the Control Panel, click on Settings.
8. Click on Course Name and Description.
9. In the Course Name field, enter any name you would like for your class.
10. In the Description text box, enter any description you would like for this class.
11. If desired, choose an appropriate subject area and discipline from the drop-down menus. You do not need to do this and it will not affect your course.
12. Click the Submit button at the bottom of the page. If you don’t see the Submit button, use the scroll bar at the right side of the screen to scroll down the page.

*Note: all areas of Blackboard are designed similarly so that you, as the instructor, do not have to guess where to go to do the same process. There will always be a Cancel and Submit button at the bottom of the page.*

Presenter: Barbara Dent
13. On the next screen, you will get a “receipt” that tells you your settings have been updated. Click **OK**.

**Manage Course Menu**

As the instructor, you may want to add and/or modify the names of content areas or tools on your site.

14. Click on **Manage Course Menu** from the **Course Options** section of the **Control Panel**. Each area represents a button on the opening page of your course. You can change the name for an area by clicking on the **Modify** button to the right of the area.
15. In the **Update** window, select a new name from the drop-down menu or enter your preferred name into the box directly below. Click the **Submit** button when done. Click **OK** when you receive the Receipt message.

16. You can also add new buttons to your course. From the top section of the **Manage Course Menu** window, select from one of the icons: add a **Content Area**, **Tool Area**, **Course Link** or **External Link**.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Area</td>
<td>Add a new Content Area to the course and choose which Course Roles will have access to it.</td>
</tr>
<tr>
<td>Tool Area</td>
<td>Enables the instructor to add Tools to the course and choose which users will have access to it.</td>
</tr>
<tr>
<td>Course Link</td>
<td>Allows instructor to add a link to another area within the course, thereby providing students with direct access to course tools and materials.</td>
</tr>
<tr>
<td>External Link</td>
<td>Enables the instructor to add an External Link area to the course so that users will automatically be taken to the URL linked to this area.</td>
</tr>
</tbody>
</table>
17. A new window will appear: **Add New Area.**

18. In the example above, a new Content Area was chosen. Select a name from the drop-down menu or create your own name in the space directly below. For easiest viewing, a maximum of 18 characters is recommended.

19. Select the appropriate check boxes to make this area available to Guests, Observers and/or enrolled users. Check with your System Admin to see what restrictions may be placed on access to your course.

20. Click the **Submit** button when done.

21. If you wish to change the order of the content buttons, use the drop-down menu preceding each course area in the **Manage Course Menu** window to put the content in your preferred order.
When you return to the Course Menu, you will see your additional buttons. If not, click the Refresh button on the Course Menu bar.

This same procedure would be used to add a Tool area, a Course Link, or an External Link to the Course Menu. Adding these area buttons makes it quicker for the user to access certain areas of your course. For the Tool area, these are the drop-down menu choices: Remember, you always have the option to create your own name for the area.

22. In some selected Tool areas, you can click on the Modify button to the right of the area name in the Manage Course Menu window to enable/disable certain components of the tool according to your preferences.
For example, in the *Communications tool*, there are several options. Once you have made your choices, click the **Submit** button.

![Tool Availability](image)

**Manage Tools**

Blackboard allows you to control the availability of all the course tools through the Manage Tools area of the Control Panel. You can decide what areas you want available to which users.

23. Select **Manage Tools** from the **Control Panel**.
24. Click on **Tool Availability**.
25. Check the boxes next to the tools that will be used in your course. You can also choose which tools will be available for **Guests** and **Observers** to access. **Guests** are defined as users who are able to view the areas of your course, but they cannot participate in any way. **Observers** are users assigned to observe a particular course. Some tools may be automatically turned off by your sysadmin.

These tools allow for such functions as:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Book</td>
<td>Store contact information about fellow students in the course here</td>
</tr>
<tr>
<td>Announcements</td>
<td>Post important information about the course</td>
</tr>
<tr>
<td>Calendar</td>
<td>Listing of course events</td>
</tr>
<tr>
<td>Collaboration</td>
<td>Synchronous tool allowing for a Virtual Classroom and Lightweight Chat</td>
</tr>
<tr>
<td>Discussion Board</td>
<td>Asynchronous tool with discussion threads and responses</td>
</tr>
<tr>
<td>Drop Box</td>
<td>Electronic file exchange between instructor and students</td>
</tr>
<tr>
<td>Email</td>
<td>Send email to other students and instructors in the course</td>
</tr>
</tbody>
</table>
Gradebook | Listing of quiz grades completed through online assessment in Blackboard
Groups | Listing of groups in the course and access to private group areas
Manual | Online resource guide to functions and features of Blackboard software
Personal Information | Update email address, change password, set CD drive on own computer
Roster | List of student's names and their email address
Staff Information | Information about the instructor(s)
Student Gradebook | Student's view of his/her own grades
Tasks | Listing of course related tasks created by the instructor

26. Once you have selected your preferences, click the **Submit** button at the bottom of the page. You may have to scroll down to see it.

27. On the next "receipt" screen, click **OK**.

Look at the top of the page and you will notice a series that outlines the path of the section of your course. This is known as the **bread-crumb trail** and provides a navigation tool back to the other sections:

28. Click on the words **Control Panel** in the bread-crumb trail to return to the **Control Panel**.

**Defining Buttons/Text navigation style**

You can change the Course Menu design for your course to add “personality” to your course Web site.

29. In the **Course Options** section of the **Control Panel** click on **Course Design**.

30. Click on **Course Menu Design**.

31. Select the navigation style for your course: **buttons** or **text**.

32. If you select **Buttons**, you will see an additional set of details outlining the type, shape and color style of your preferred button. If you click on the words **Gallery of Buttons** you will be able to see all the buttons of that type. Click on your desired button to select it and be returned to the **Course Design** page.

33. Click the **Submit** button at the bottom of the page.

34. Click **OK** on the next "receipt" page.

35. If you select **Text**, you will be asked to select a background color for the Course menu, and a text color from the color palette.

36. Click the **Submit** button at the bottom of the page.

37. Click **OK** on the next "receipt" page.
**Add a banner**

You may also like to add a banner at the top of your Announcements page of your course. Banners can function as thematic images for your course content, such as a picture of Mark Twain when reading *Huckleberry Finn*. Two Internet sources for creating text banners are [http://www.3dtextmaker.com/](http://www.3dtextmaker.com/) and [http://www.flamingtext.com/](http://www.flamingtext.com/).

38. If you did not return to the **Course Design** window after the previous exercise, click on the **Control Panel** button and, in the **Course Options** section, click on **Course Design**.
39. Click on **Course Banner**.
40. Click on the **Browse** button.
41. Navigate to the folder where you have stored your image for your course banner and then select it. (*Note: the suggested size for the banner is 450 x 90 pixels.*) Click **Open**.
42. The computer path to your banner will appear in the **New Banner** field. Click **Submit**.
43. Click **OK**. If you would like to see what your new banner looks like, click on the Course ID Number (i.e., NESA Blackboard Training) in the bread-crumb trail.

**Course Availability**

44. From the **Control Panel**, go to **Course Options > Settings**.
45. Click on **Course Availability**
46. If you want to make this course available to your students immediately, click the **Yes** radio button. If you would like your course to remain unavailable to students until a later time, click the **NO** radio button. Although you may have all your students enrolled in your course, they will not be able to access your course until you make it available to them. Many teachers will develop their course first and set the course availability later; others make it available immediately and add course content as the course progresses.
47. Click the **Submit** button at the bottom of the page.
48. Click **OK** on the next "receipt" page.

Now that you have set up the course to look like you want it, you are ready to add content to the course. If you ever want to change the appearance of your course or make changes to the various sections, you can always go in to the **Control Panel** to make those changes.
Course Content: What do you want to include in your course?

From the Control Panel, you can use the tools in the Content Areas section to add and manage information, materials, assignments and assessments in your course. Here is where you can incorporate text, slideshows, audio/video files, as well as create sequential Learning Units. The Content Areas now include any new areas that you added/created from the Manage Course Menu previously.

- Course information

This area is ideal for posting your course syllabus, grading policy, project guidelines, field trip forms or any general information your students need to be able to access.

Before going on, take a moment now to launch Microsoft Word and create a short document (2-3 sentences). Name it practice.doc and save it to the desktop. You will use this document in this workshop in the following process.

49. In the Content Areas section of the Control Panel click on Course Information (or your customized name when you set up your Course Menu).
50. From the menu in the Course Information window, you can choose to add an individual item or a folder. This is where planning your course become crucial to your students' navigational demands. In this workshop you will practice posting both an individual item and a folder. Click on Add Item.

51. In Section 1 from the Name Drop-down menu, choose a type of content or enter your own title in the “specify your own name” field. If desired, click on the Pick button to select a color from the color palette for the title.
52. In Section 1, in the text box, you can choose to enter the information directly into the text box or you may copy and paste from another document. For this workshop, enter the text “This is an example of how easy it is to post information in Blackboard.” and hit the Enter key.
53. Now open your practice.doc file on the desktop and copy the contents.
54. Toggle back to the text box in Blackboard and paste your contents.
55. Since the text box functions just as a word processor, you can change the font styles, color, size and you can spell-check your work; then click Preview to view the text as it will appear.
56. In Section 2, you can add any attachments. For example, if you already had your syllabus created as a document, it would make more sense to add it as a document than re-enter the text in the text box. The best type of attachment to add is a rich-text document, a PDF document or a Word document. You can also add image files. Click the Browse button next to “File to attach.”
57. Navigate to the location where you have stored your file and then select it. For this workshop, navigate to the desktop and select your file, practice.doc. Click Open.
58. The computer path to your file will appear in the “File to attach” field.
59. In the Name of Link to File field enter any appropriate name for your file (i.e., syllabus, field trip guidelines).
60. In the Special Action field, select Create a link to this file for the file to open as a separate page. We will address the other options a bit later.
61. In Section 3, select the Yes radio button to make the content visible.
62. Leave the Dates of Availability boxes unchecked if you are not restricting the starting and ending dates of your document.
63. If you would like to track which of your students access this document, select the Yes radio button for “Track number of views”
64. Click Submit and then OK.

- Course documents
Teachers may use this area to post class lecture notes, or other handouts pertinent to the course.

65. In the Content Areas section of the Control Panel click on Course Documents (or your own customized name).
66. You now have to choose the nature of your material from the top menu:

67. For this workshop, select Add Folder.
68. Select a name that describes your folder, or enter your own name for it.
69. Click **Pick** to select an alternate color for the name of the item. Since you are creating a folder, it is a good idea to enter a short description of the contents of the folder in the text field. To enter text, just type directly into the box or copy/paste from another source.
70. From the **Options** section of the window, choose the date restrictions, if you wish, and select whether you want to make the folder visible to your users.
71. Click **Submit** when done.

Folders in Blackboard are just like manila folders in a filing cabinet. They are a way to organize content. Many teachers create folders to hold all materials for a special project or create folders to hold all the homework assignments for a specific week or month.

Once the folder is created, you can click on the folder name and add individual items, folders, links, Learning Units, and course links within that folder.

72. Now we will add an item to the folder we just created. Click **Add Item** to access the Add Item page.
73. Just as we did for a Content Area folder, select a name for your item or create a customized name.
74. Enter your text in the text box. Your options include:
   1. type text directly into the text box
   2. copy and paste text from another word processing program
   3. use HTML tags in coded text
   4. use the WebEQ Equation Editor to insert scientific or mathematical equations:

75. Finally, spell-check your work and click Preview to view the text as it will appear.

If you would like to attach a file to the item as a link or the actual file contents, click Browse in the Content section of the Content Information window and follow the same instructions for attaching a file that we did previously.

76. Your course documents may include media or zipped files. In the Special Action drop-down menu, select from:
   - Create a link to this file
   - Display media file within the page (embeds certain kinds of media into the page rather than linking to it)
   - Unpackage this file (i.e., a .zip file will be unpackaged before displaying). On the File Options screen select the Entry Point of the zipped file link by highlighting the index.htm file from the list.
Note: If you choose to Display a media file, the attached file must be a format recognized by Blackboard. These are some of the many formats accepted:

<table>
<thead>
<tr>
<th>Extension</th>
<th>File Type</th>
<th>Programs associated w/file type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.aam</td>
<td>Multimedia</td>
<td>Macromedia Authorware plug-in</td>
</tr>
<tr>
<td>.au</td>
<td>Audio</td>
<td>Real Audio Player</td>
</tr>
<tr>
<td>.doc</td>
<td>Text</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td>.exe</td>
<td>Executable</td>
<td></td>
</tr>
<tr>
<td>.gif</td>
<td>Image</td>
<td>Graphics, Web Browser</td>
</tr>
<tr>
<td>.html, .htm</td>
<td>Web page</td>
<td>HTML editor, Web Browser</td>
</tr>
<tr>
<td>.jpg</td>
<td>Image</td>
<td>Graphics, Web Browser</td>
</tr>
<tr>
<td>.mpg</td>
<td>Video</td>
<td>Movie, media player</td>
</tr>
<tr>
<td>.pdf</td>
<td>Text</td>
<td>Adobe Acrobat Reader</td>
</tr>
<tr>
<td>.ppt, .pps</td>
<td>Slide show</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>.qt</td>
<td>Movie</td>
<td>QuickTime</td>
</tr>
<tr>
<td>.ra</td>
<td>Audio</td>
<td>Real Audio Player</td>
</tr>
<tr>
<td>.swa</td>
<td>Audio</td>
<td>Macromedia Shockwave plug-in</td>
</tr>
<tr>
<td>.swf</td>
<td>Multimedia</td>
<td>Macromedia Shockwave plug-in</td>
</tr>
<tr>
<td>.txt</td>
<td>Text</td>
<td>Text or HTML editor</td>
</tr>
<tr>
<td>.wav</td>
<td>Audio</td>
<td>Audio program</td>
</tr>
<tr>
<td>.wmv</td>
<td>Media/Audio</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>.wpd</td>
<td>Text</td>
<td>WordPerfect</td>
</tr>
<tr>
<td>.xls</td>
<td>Spreadsheet</td>
<td>Microsoft Excel</td>
</tr>
</tbody>
</table>

77. In the Options section of the Content Information window, make your selections. Remember to make the content visible to your users, if that is your wish at this time. 78. Click Submit when done; and OK to your receipt.

If you want to rearrange the order in which items appear, simply use the numeric drop-down menus to the left of each item. Choose “1” for the first item, “2” for the second, etc.

You can also modify any item or folder at any time by clicking on the Modify button to the right of the folder/item name.

- External links
Instructors are able to add Web links at any point in the Course Content. So, if you are doing a lesson on a certain topic, you can include links to pertinent web sites in the same folder as your lesson contents. You still have the option of creating a separate External Links content area for all your web links.

79. In the Content Areas section of the Control Panel click on Course Documents. 80. Click on External Link.
81. In Section 1 of the External Link page, in the **Name** field, type the title for your web site. The title can be anything you want.

82. In Section 1, in the **URL** field, type the internet address for your web site. Be sure to include `http://` as part of the URL.

83. In Section 1, in the **Description** field, type a description of the web site (or a description of what students should look for at the web site).

84. In **Options**, Section 3, select the **Yes** radio button to make the link visible.

85. Also in Section 3, choose whether or not you would like the site to launch in an external window.

86. Click **Submit**, then **OK**.
Learning Unit

A Learning Unit is a special type of folder. Items placed in a Learning Unit are intended to be viewed in sequential order. An instructor can set Blackboard so that the next unit cannot be viewed by the participant until they have viewed the previous unit. You can also allow the student to access the content nonlinearly.

The content for a Learning Unit is created the same way as in other Content Areas. Individual items and files may be added, arranged, and modified to create a sequential learning path.

Once you open a Learning Unit window, you will need to choose your desired Options for setting up your Learning Unit.

- **Options**
  - **Make the content available**
  - **Enforce sequential viewing of the Learning Unit?**
  - **Open in new window**
  - **Track number of views**
  - **Choose date and time restrictions**
    - Display After:
      - Date: Feb 27, 2006
      - Time: 07:00 PM
    - Display Until:
      - Date: Feb 27, 2006
      - Time: 07:00 PM

- **Submit**
  - Click Submit to finish. Click Cancel to quit.
  - *Required Field*

Announcements

Announcements can be used for anything that you want to tell your students. This area is ideal for posting time-sensitive information.

87. In the Course Tools section of the Control Panel click on Announcements.
88. Click on the Add Announcement button.

89. In Section 1, in the Subject Field, type a brief headline for your announcement.
90. In Section 1, in the Message Field, type your message.
91. In Section 2, after the question “Permanent announcement?,” select your preference. By default, an announcement appears for seven days.
92. Leave the Date Restriction boxes unchecked. Blackboard does give you the option of creating an announcement in advance and then having it display automatically at a pre-selected date. The date restriction feature allows you to control...
both the starting and ending dates of any announcement. If you leave the **Date Restriction** boxes unchecked, all your announcements will show in the announcements section in chronological order, the most recent first.

93. If you wish to place a link to another location in your course, click the **Browse** button in Section 3 to determine the destination.

94. In Section 4, click **Submit** and then **OK**.

Your announcement will now show in the **Announcements Control Panel**. If you want to change it, click on the **Modify** button. If you want to remove it entirely, click on the **Remove** button. If you like it the way it is, click on **OK**.

- **Staff information**
  This area can be used for anything that you want to tell your students about yourself.

95. In the **Course Tools** section of the **Control Panel** click on **Staff Information**.

96. Click on the **Add Profile** button.

97. In **Profile Information**, Section enter all information about yourself that you want to be visible to your students.

98. In **Options**, Section 2, select the **Yes** radio button to make the profile visible.

99. In Section 2, if you would like to add a picture of yourself to the page, click on the **Browse** button and navigate to the location where you have stored your picture and then select it. For best results, the image size should be 150x150 pixels. Click **Open**.

100. The computer path to your picture will appear in the **Attach Image** field. Click **Submit**.

101. Click **OK** on the “receipt” page.

102. If you would like to add another profile (i.e., team teacher’s info), click the **Add Profile** button. If you are finished adding and/or modifying profiles, click **OK**.

**Presenter:** Barbara Dent
• Assignments
This area can be used to post your homework assignments. Assignments list the name, point value, and a description for class work. The instructor can also include an attachment to the Assignment. Students can then complete the assignment in a separate file and send it back to the instructor for assessment. The final assessment will appear in the Gradebook.

103. In the Content Areas section of the Control Panel click on Assignments or any name of the Content Area.
104. Select Assignment from the drop-down menu to the right. Click on the GO button to get to the Add Assignment screen.

105. Follow the instructions for adding other course content; the process is very similar. There is a field where you can enter the total number of points possible for the assignment.
Note: be sure to provide clear directions to your students so there will be less room for error on their part in completing the assignment!

106. If you wish to attach an assignment, click Browse in the Assignment Files section of the window and select a file to attach.
107. After completing the assignment, your student clicks on the “View/Complete” button to upload the assignment.

108. Students will be prompted to Browse to find their file, and they can also post Comments to you about the assignment. Such comments will appear in the Gradebook, as well as the completed assignment.
Congratulations! Now you have a great start on the contents of your course!

Course Communication: How will you and your students “talk” in the course?

- **Asynchronous:**
  In an asynchronous communication, the "sender" and "receiver" do not have to be in the same place at the same time. Extending a classroom discussion beyond the class period, having students turn in work in digital format, and sending updated or emergency information to your class are all examples of asynchronous communication.

  - **Discussion Board**
    The basic component of the **Discussion Board** is a message, or post. A message is 'posted' by a user. Messages may also include an attached file (text, audio, or image). Because the **Discussion Board** is an asynchronous tool, other users do not have to be online at the time of posting to read the message; they can read it at any time.

    Messages are organized into threads. A **thread** is an original message and all the messages that are responses to that message. In Blackboard, **threads** are stored in **Forums**. Each **Forum** can be assigned different properties, such as allowing users to
post messages anonymously or allowing users to edit or remove their own messages after they have been posted. You, as the instructor can set up multiple Forums to organize the various classroom discussions around different topics.

Instructors and enrolled students access the Discussion Board through the Discussion Board course menu button. Only instructors can create Forums.

111. Click on the Discussion Board button.
112. Click the Forum button.
113. Enter a name for the forum, a description, and any instructions. The Available radio button is selected as the default.

114. Choose your forum settings for allowing your users to post anonymously, edit, remove, or create new threads:

Recommended Forum Settings:
You will probably not want to allow anonymous posts. Many instructors like to allow students to post file attachments to the discussion board so that students can peer review assignments and other writing projects they are working on. Allowing students to create new threads simply means that they can start new topics within the discussion forum rather than forcing students to respond to instructor-initiated threads.
Allow members to rate posts: post rating allows users to rate posts in the forum on a scale of one to five stars. When enabled, post rating is a simple yet effective tool for peer review.

Force moderation of posts: If moderation is enabled, when a user other than a Moderator or Manager submits a post, the post is saved to the Moderation Queue. New posts are displayed in the queue for review and publication. If a post is returned, a return message can be attached to the post allowing the Moderator to inform the user why the post was not accepted for publication.

Grading: When enabled, Instructors, Teaching Assistants, and users with the Grader or Manager forum roles will be able to access the Grade Forum Users page. Instructors may choose to grade the forum or to enable thread grading within the forum. If thread grading is enabled for the forum, instructors have the option to turn grading on or off for each new thread.

115. After you choose your forum settings, click Submit to create the forum.

   o Forum View

116. The forum will now be listed in the Discussion Board area. If you have multiple forums you can place them in the order you want using the number boxes next to each forum title.

117. Click on the blue forum title link to access a discussion forum. The forum opens and the discussion threads appear. The list of threads can be sorted by clicking the carat at the top of each column. Posts within the thread are viewed by clicking on the hyperlinked name of the thread in the Thread column.
The functions at the top of the page include a Display option and Search function. There is also an action bar that includes the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thread</td>
<td>Initiates a new thread</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected threads from the forum. Deleted threads cannot be restored. Use the unavailable function to completely hide threads from users without actually deleting the threads.</td>
</tr>
<tr>
<td>Collect</td>
<td>Collects selected threads onto one page where posts can be sorted, filtered, or printed.</td>
</tr>
<tr>
<td>Lock</td>
<td>Prevents new posts from being made to that thread.</td>
</tr>
<tr>
<td>Unlock</td>
<td>Allows users to modify and add to the thread.</td>
</tr>
<tr>
<td>Grade Forum</td>
<td>Only appears if grading option is enabled for the forum.</td>
</tr>
<tr>
<td>Change Status to</td>
<td>Updates the availability status of the selected threads.</td>
</tr>
<tr>
<td>Moderate Forum</td>
<td>Only appears if moderation of posts option is enabled for the forum.</td>
</tr>
<tr>
<td></td>
<td>Allows the instructor to approve/reject posts before they are viewable by other users.</td>
</tr>
</tbody>
</table>

118. To create a new thread (begin a new conversation or topic) click on the **Thread** button in the action bar.
119. Enter a subject and your message. It is important to enter a brief, clear subject.
120. Attach a file to your threaded message in the **Attachment** area if you have a document to share with a group.
121. Once you have finished, click **Submit**.
○ Thread View
Clicking on a thread in a forum brings up the Thread Detail. The thread view is divided into three sections. Post viewing and management functions appear at the top of the page (1). The middle of the page (2) displays a list of posts, with replies nested below the original post. The bottom of the page (3) displays the current post.

The following options are available when viewing a thread:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect</td>
<td>Group posts into an organized filterable and sortable set that can be printed.</td>
</tr>
<tr>
<td>Flag</td>
<td>Mark a post for later attention.</td>
</tr>
<tr>
<td>Clear flag</td>
<td>Remove a flag applied to a post.</td>
</tr>
<tr>
<td>Grade Thread</td>
<td>If this option was enabled upon the forum creation, enter a grade for a user based on their performance in the thread.</td>
</tr>
<tr>
<td>Moderate Forum</td>
<td>If this option was enabled, it allows the instructor to approve/reject posts before they are viewable by everyone in the class.</td>
</tr>
</tbody>
</table>
Additional options are available within the current post:

- **Reply (1)**: Generate a response to a post.
- **Modify (2)**: If enabled by instructor, change the content of the post.
- **Remove (3)**: If enabled by instructor, remove the post (this also removes all the replies to that post).
- **Rate this Post (4)**: Select a score for the post on a 1 to 5 scale.
- **Previous Post/Next Post (5)**: Click these options to navigate through the posts in the thread.

### Respond to a Thread

122. Click on the Reply button at the top of the message box.
123. In the Reply to Post window, fill in the Subject and Message fields.
124. If desired, attach a file to the message.
125. Scroll down to the bottom of the page and click the Submit button.
126. You can use the Previous Thread | Next Thread and Previous Post | Next Post to navigate through the discussion board. This results in a write-and-reply dialogue among your students.

### Rate Posts (Peer Review)

A common learning tool in classrooms is providing feedback to other students on their work. Students prepare an essay, lab report, or presentation and share it with the class. Other students are asked to comment on the work and offer criticisms for improvement. This process helps the student improve their assignment, but is even more valuable to the students who review the work. The Discussion Board is the perfect place in a course for peer review. Each student may start a thread and include their work in the initial post. Other students then review the work, assign a rating to the initial post, and include comments in a response. As users respond, the feedback expands as users reinforce and build on points made by classmates.

Students can respond to a post using a 5-star rating system. To enable this feature, select **Allow members to rate posts** when creating the forum.
127. To rate a Discussion Board post, students open a thread and view the posts. Each post has an **Overall Rating** field with five stars. The stars show the overall rating that the post has received from users.

128. Click on the **Rate this Post** drop-down menu and select a rating from 0 to 5 stars.
129. Click the **Rate** button.

130. Your rating is now included in the **Overall Rating**. A user may not rate the same post more than once.
Thread Status

The Forum Manager can change the status of a thread to one of the following:

**Published:** A published thread is available to users.

**Hidden:** Hidden threads do not display unless the user chooses. Hidden threads may not be modified. Hiding threads removes outdated threads and makes relevant content easier to find.

**Unavailable:** Unavailable threads are only visible to forum managers. Even then, forum managers must choose to view these threads. Making threads unavailable means that users can no longer view the thread.

131. To change the status of a thread, open a forum in the Discussion Board.

132. Select threads by placing a check mark in the box before the underlined thread.

133. Choose a new status for the selected thread(s) using the Change Status to: drop-down menu.

134. Click the Go button.

Additionally, the Forum Manager can lock and unlock threads from the forum action bar:

**Locked:** Users may read the thread but not make any additions or modifications. Locking a thread allows grades to be assigned without users updating or changing posts.

**Unlocked:** Allows users to modify and add to the thread.
Moderate a Forum

There are several ways to keep the Discussion Board content safe and to avoid inappropriate material for class discussions.

135. From the list of forums on the Discussion Board, select the Manage button.

136. Assigning a user the role of Blocked from the Forum Role drop-down menu will prevent the user from accessing the forum. Assigning a user the role of Reader will allow the user to view content but prevent the user from posting content. (NOTE: The default value is Participant. Participants can read and post.)

137. Another option is assigning a user to act as Moderator. The Moderator may be the instructor or other responsible participant. Moderators review posts before they are added to a thread and displayed to the class.

138. Click OK to complete the forum roles.

139. To moderate forum posts, open the forum.

140. Click the Moderate Forum button in the action bar (this button will only appear if you have a forum role of Manager or Moderator).
141. The **Moderation Queue** window will appear with a list of posts that are awaiting approval. The posts appear in chronological order. Those at the top have been in the queue for longer than those at the bottom.

142. Click the **Moderate** button for a post.
143. The **Moderate Post** page will appear displaying the post message.

144. Select **Publish** or **Return**. If returning the post, add a message to the author explaining why the post is being returned and some suggestions for modifying the post so it is appropriate for the discussion.
145. Click **Submit**. If the post is approved it will now be shown in the forum. If the post is not approved, it will only appear to the author and the **Moderator** in the forum. The post will be marked returned and the **Moderator**’s comments when returning the post will appear as a reply.

- **Grading Discussion Board Participation**

Student interactions with the Discussion Board are a permanent record of participation. The instructor has the option to grade students at the forum level or at the thread level. In this way the instructor can accurately compare student participation to the expectations set forth in the course.

Grading options are enabled when the forum is created (refer to page 23) or by modifying a forum already created:

146. Go to the Discussion Board and click on **Modify** to the right of a forum to change its settings. The **Grade** settings appear on the **Modify Forum** page.

147. Select **Grade Forum** and enter a point value to evaluate users on performance throughout the forum, or select **Grade Threads** to evaluate users on performance in each thread. When the **Grade Threads** option is used, a **Points Possible** option appears each time a thread is started. (NOTE: Users cannot create new threads if **Grade Threads** is selected for the forum.)

To evaluate performance in a forum:

148. Open the Discussion Board and click the icon in the **Grade** column for the graded forum. Only users with a forum role of **Grader of Manager** may enter a grade for a forum.
149. A list of users will appear. Click **Grade** for a user.

![Grade Forum Users](image)

150. A collection of the user’s posts in the forum will appear. Evaluate the posts and assign a **Grade**.

![Grade: InstructorOne](image)

151. Click **Submit** to add the grade to the Gradebook.

Evaluating performance within a thread is very similar – open a forum and select a thread. Click **Grade Thread** and click **Grade** for a particular user to assign a **Grade**.

- **Manage/Create Groups**
  
  A great feature of Blackboard is the enrolling of students into smaller groups of students in order to focus on interactivity or to work collaboratively. The **Group Pages** function allows you to set up areas of the course that will only be accessible to specific groups of students. In this area, you can give each group its own **Discussion Board**, **Email**, **Virtual Classroom**, and **File Exchange** areas. This feature is useful when you assign group projects, peer review groups, or other situations where group work is important.

  152. On the **Control Panel**, click on **Manage Groups** from the **User Management** area.
  153. Click on **Add Group**
154. Enter a **Name** for the Group.
155. Enter a **Description**.
156. Select the functions you want to enable from the **Group Options**: discussion board, virtual classroom, file exchange, email.

157. Click on **Submit**, then **OK**.
158. Once you have created a group, you need to add users to that group. From the **Control Panel**, click on **Manage Groups** and click on the **Modify** button to the right of the group name.
159. You will now have access to the **Manage Group** page where you can **Add Users to Group**. The process is similar to that of enrolling users in your course.

![Manage Group Page](image)

160. Choose the users you wish to make part of the group by clicking in the checkboxes next to the users and click **Submit**. Click **OK** on the receipt page.

Now you are set up to enter collaborative projects into your course!

**User Management: Who’s in your course?**

Students must be added to your course in order for them to “see” the course.

In the Fairfax County Public School system, accounts are made for all students by the county Blackboard administrator and students are automatically enrolled in each section of a course a teacher teaches. Each student’s user name is their unique student ID number. Students can be added or moved manually using their last name or their student ID. Check with your System Administrator to find out the preferred method of creating student accounts.

- **Enroll users**
  161. Select the class to which you need to add students. Click on the **Control Panel**.
  162. In the **User Management** area of the **Control Panel** click on **Enroll User**.
  163. Enter the desired student’s *Last Name* or *User Name* in the **Search** box and be sure that the **correct** radio button is selected.
  164. Click on the **Search** button.

**Note:** An alternate method is to select the A-Z or 0-9 tab to search for last names that start with a particular letter or number.
165. When the student appears on your screen, click in the **Add** box to the left of the student’s name.

166. Click **Submit** and then **OK**. You will be returned to the **Control Panel** area. Repeat this process for each student that you want to add.

- **List/Modify users**
  You can change the role of your users, i.e., Student, Instructor, Teacher’s assistant, Grader, Guest, and Course Builder. Additionally, you will go to this area to change a user’s password.

167. Under **User Management** in the **Control Panel**, click on **List/Modify Users**.

168. Click on the **Search** button. You will see a page with the search results:

169. To change the role of your course participants, click on the **Properties** button to the right of their name.
170. Scroll down to Section 4 where you can change the **User Role**.

![Role and Availability form](image)

Here is a summary of the available roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>User is able to access all available Course content and will be graded on Assessments</td>
</tr>
<tr>
<td>Instructor</td>
<td>User is able to control all aspects of the course through the Course Control Panel</td>
</tr>
<tr>
<td>Teaching Assistant</td>
<td>User is able to control most aspects of the course through the Course Control Panel</td>
</tr>
<tr>
<td>Grader</td>
<td>User is able to access all areas under Assessments</td>
</tr>
<tr>
<td>Course Builder</td>
<td>User is able to add content to the course through the Content Areas and the Course Tools on the Course Control Panel</td>
</tr>
<tr>
<td>Guest</td>
<td>Guests are able to view areas of the course, but cannot participate in any way</td>
</tr>
</tbody>
</table>

171. Make your selection and click the **Submit** button, then **OK**.

*Note:* To change a user’s password, return to **List/Modify Users** in the **User Management** area of the **Control Panel**. Once you have searched for the user, click the **Password** button next to a user to modify their information.

![List/Modify Users](image)
Now you have students enrolled in your course and you are ready to embark on an exciting teaching experience!

Resources on Blackboard

- **Blackboard Support**
  To get assistance within the NESA Blackboard site, if you click on the *Help?* button in the upper right-hand corner of your window you will be have access to Blackboard’s support.

- **Manual and Tutorials**
  An instructor’s manual is available from the *Control Panel > Help > Manual*, as well as tutorials from *Control Panel > Help > Quick tutorials*.

- **Online Tutorials**
  Many universities using Blackboard have tutorials and documentation posted on their websites that can also help you. Here are just a few:
  - http://www.utexas.edu/academic/blackboard/tutorials/
  - http://blackboardinfo.newark.rutgers.edu/tutorials.html
  - http://www.princeton.edu/as/bb_animated_tutor.shtml
  - http://otel.uis.edu/bbtutorial/
  - http://slisweb.sjsu.edu/blackboard/
  - http://atcpod.scranton.edu/tutorial.html
  - http://www.cvtc.edu/Tutorials/Blackboard.htm
  - http://www.blackboard.com/products/quicktutorials
  - http://www.ocdsb.edu.on.ca/Teacher_Res/eLearning/bb_tutorials.htm